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Chapter 1. About this document

This document is intended for application programmers or analysts working in an
IBM Application System /400 (AS/400) environment, who want to use the better
toolset provided in Development Studio Client for iSeries. It explains how to use
the Remote System Explorer, one of the tools provided in WebSphere Development
Studio Client, and compares this tool to the more traditional Programming
Development Manager (PDM).

The Remote System Explorer is a flexible, enhanced workstation version of PDM
that provides easy ways to perform everyday tasks when you use it with iSeries
projects.

* Create and manage development projects on your iSeries system from your
Windows-based workstation

e Connect to a remote iSeries server
* View iSeries libraries, files, and members

* Launch the server compilers, the workstation editor, a program verifier, and
various debuggers

This document introduces you to the similarities between PDM and the Remote
System Explorer. It also explains enhancements in the Remote System Explorer that
are not available in PDM, and describes how to accomplish the most commonly
performed tasks on your iSeries system using both methods.

The comparison between the two tools also helps you with the first step in the
iSeries Developer Roadmap: a learning path for iSeries developers who want to
adopt new technologies and improve their skills. For more information about the
iSeries Developer Roadmap, see

http:/ /www.ibm.com/servers/eserver/iseries /roadmap/index.html.

To use this document effectively, you need to be familiar with basic Windows
tasks, such as file navigation and cursor manipulation.
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Chapter 2. Starting the development environment

Typically, an iSeries programmer connects to an iSeries server using a 5250
green-screen interface. The Programming Development Manager (PDM) can be
initiated from the AS/400 main menu or by typing STRPDM command on the
command line. The PDM menu is displayed:

=l session & - [24 x 80] “ =10 x|

File Edt Wiew Communicakion Actions ‘window Help

o5 2% @@ =@ st & al @l

B Programming Development Manager (PDH)

Select one of the following:

9. Work with user-defined options

ion or command

FlA=Command entru

U |Cannected ta remate serverfhost boras07m using port 2 |pd101 on psprintl:pd101

Starting Development Studio Client

To start Development Studio Client:
1. Click Start on the task bar of your desktop

2. Select Programs > IBM WebSphere Studio > Development Studio Client
Advanced Edition for iSeries’ " 5.1.2

ﬁ |IBM WebSphere Studio 4 J:| Development Studio Client for iSenies 5.1.2 P

tudio Client fo

Note: If the Advanced Edition of the product is installed on your workstation,
you will see the words "Development Studio Client Advanced Edition
for iSeries” in the Start menu.

3. If a window opens, specify the name of the workspace where you want to keep
your projects and other resources such as folders, subfolders, and files that you



develop with the Development Studio Client workbench.

Websphere Studio x|

WebSphere Studio stores waur wark in & directary called & warkzpace. You cah change the work space each time
wou start webSphere Studio. Specify the directom to uze for thiz session:

ID:\DDcuments and Settingztchnglmeity DocumentshlBMwdsc RS Elabeds Browse... |

[~ Use thiz workspace as the default and do not show this dislog box again

(Optional) Type a unique directory name, for example, RSETabXX.
4. Click OK to start the workbench.

&b Remote System Explorer - Welcome - WebSphere Development Studico CI... [B[=] E3

File Edit Mawigate Search Project Run Window Help

| -BR&|B|s-%-&-||2|lve-2-

iy Remo..ems = x| BEROEED X l Outline
BB Development ...
2 | An outling iz
ot E | [This page tells you what you should know before = Inot available,
_— with WWebS phere Development Studio Client for iS
o =§=' zections below and click on the related links.

@ Get started |
To know what to do first, consult the Product
in the online help to decide how pou can mos

B oo @ Develop iSeries applications
& i Dot *rou can create and maintain RPG and COBC
-8 Local toals in this development environment. Use t

your iSeries_obiects, then use the built-in editil -
4| | 3

] Root Connections ’:»_EE;@ | b x ow o

LI_I _'I Hame I Farent profile I Remote syt I Conne
Hemote Syst... ‘ Team | | "B Local Private Local Some
Froperties -
B3 B
Property | Wal &

Mame MNete iI | b
1 | : | I Remate System ... | Tasks | iSeres Table View | iSeries Commands ...

[

The workbench refers to the desktop development environment (IDE). The
workbench aims to achieve seamless tool integration and controlled openness by
providing a common interface for creating, managing, and navigating workbench
resources. Each workbench window contains one or more perspectives. A
perspective defines the initial set and layout of views in the Workbench window.
Within the window, each perspective shares the same set of editors. Each
perspective provides a set of capabilities aimed at accomplishing a specific type of
task or working with specific types of resources. For example, the Java perspective
combines views that you commonly use while editing Java source files, while the
Debug perspective contains views that you use while debugging Java programs.

Perspectives contain views and editors and control what appears in certain menus
and toolbars.
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Opening the Remote System Explorer perspective

Check for the name of the perspective.

@ Remote System Explorer - :¥elcome - WebSphere Developme;

File: Earch  Project Run Window Help
[=3E (B3 -%-%-|s[|AA
E| | U Remate Systems > = l =] "-"'-" X l

If you see a different perspective from the Remote System Explorer, or no
perspective at all, then select Window > Open Perspective > Remote System
Explorer from the workbench menu bar.

e - WehS5phere Development Studio Client for iSeries
Fun | “Window Help

® - MHew window |

B Open Perspective Eﬁ % eries Projects
Show Wiew . =  Eren E=N—
" TEIT Em E xplore|
De  Hide Editars . : :
Lock the Toolbars %WebFacmg
Custamize Perspective. . Other. .

For the exercises in this document, you will work in the Remote System Explorer
perspective, which is designed for iSeries programmers. This perspective is where
you can create new connections to an iSeries server, work with iSeries files,
commands, jobs, and integrated file system files.

This perspective is active when you start Development Studio Client, loaded with
a new workspace. If you have used a workspace before, the workbench opens with
the perspective that you last used. You use this perspective to launch the iSeries
programmer tools and views in the workbench.

Configuring a connection and connecting to an iSeries system

When you first open the Remote System Explorer, you are not connected to any
system except your local hard drive on your workstation. Before you can connect
to a remote iSeries server, you need to define a connection. When you define a
connection, you specify the name or IP address of the remote system and you give
the connection a unique name that acts as a label in the workbench, so that you
can easily connect and disconnect. When you connect to the iSeries system, the
workbench prompts you for your user ID and password on that server.

The first time you connect to an iSeries server, you need to specify a profile. All
connections, filters, and filter pools belong to profiles. We will discuss profiles after
you create your first connection.

To configure a connection:

1. In the Remote Systems view, New Connection is automatically expanded to
show the types of various remote systems you can connect to through the
Remote System Explorer. Click the plus sign (+) beside iSeries to configure a
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connection to an iSeries server.

! o v M
2@ oo p| S

E|=é,'§ Mew Connection
LAY windaws...

f) Lirx. ..

Unix Unix, ..

Remaote Systems JTeam

2. In the Name personal profile page, leave the default value in the Profile field
and click Next.

Name personal profile

Uniquely name user profile !

Welcome to Remote Systems. Connections can be sharable by the team or private ko
wou, Enter a profile name to uniquely identify wou From your keam members, You wil

decide for each new connection whether it is owned by the team profile or wour
prafile,

Profile: | ¥URICH

e A,
= Back, w Firish Cancel
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3. On the Remote iSeries System Connection page, specify the information for
your connection.

Remote iSeries System Connection

Define connection information !

Parert prafile: I‘."URICH j
B o,

Connection namg Is4EIDa \

Hast name: Qﬂlﬁ/ j

Description: I |

@Verifv host name

< Back, | Mext = | Cancel |

4. In the Host name field, type the IP address or the name of your server system,
for example, s400a.

The Connection name is automatically filled with the server name for your
convenience. This name is listed in your Remote Systems view and must be
unique to the profile, so you probably want to accept the default value.

5. Leave the default value for the Parent profile field. For this exercise, you can
accept the default parent profile to keep your files private. For future
development, you can choose to share your files and resources by selecting the
Team profile.

6. Leave the Verify host name check box selected.

7. Click Finish to define your connection.

After you configure a connection to an iSeries server, you can easily connect and
expand your new connection to reveal your subsystems. Subsystems are
predefined filter groupings of the various types of remote resources that can be
explored in the remote system. Your iSeries connection gives you access to four
subsystems:

* iSeries Objects is a PDM-like group, enabling access to libraries, objects, and
members

* iSeries Commands contains predefined commands you can run against remote
objects. You can also create command sets, each of which contain one or more
frequently used commands. When run, all commands in a command set are sent
to the remote system and executed, and the results are logged in the iSeries
Commands log view

* iSeries Jobs displays various jobs, subset by job attributes, and enables you to
perform a number of operations on those jobs.

¢ IFS Files helps you explore folders and files in the Integrated File System of the
remote iSeries server.
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DA e e
E|=E'.'§ Mew Connection
A windows. ..
CoEed Linox...

-Unin nix,.,

i E-E Local.
E& iSeries., ..
H [ Connection created successfully, |

'E. Local

‘a
=@y iSeties Ohjects

:%:b ‘Wark, with libraries. ..
:%:D ‘Wwaork with objects. ..
:%:b Wark, with members. ..
W Library lisk

iﬁb User libraries

gk iSeries Commands

gy iseries Jobs

Bl Ty IFS Files

4] | -+

Remaote Systems JTeam

To connect to an iSeries system:

1. In the Remote Systems view, your new connection is automatically expanded to
reveal your subsystems. The iSeries Objects subsystem is the subsystem you
will use most often. It is very similar to PDM, in that it allows you to access
objects in the QSYS file system and perform actions on those objects.

2. Notice that the first three entries under the iSeries Objects subsystem are
named after PDM options, because they have similar capabilities:

* Work with libraries (similar to WRKLIBPDM)

* Work with objects (similar to WRKOBJPDM)

* Work with members (similar to WRKMBRPDM)

In addition, there are entries for working with library lists and user libraries:
* Library list (similar to STRPDM, Option 1, *LIBL)

* User libraries (similar to STRPDM, Option 1, *ALLUSR)

A closer look at the user interfaces

The most obvious difference between PDM and the Remote System Explorer is the
user interface. PDM is text-based, while the explorer is a graphical user interface.
Although the interface looks different, the underlying features are similar.
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To apply an action to an object in PDM, type the number of a particular action
beside the object (in the Opt column) and press the Enter key.

=l Segsion A - [24 x 80]

File Edit “iew Communication Actions ‘Window Help

PF

More...

1902 - Session successfully stared

In the Remote System Explorer, right-click on the object and select the action you
want from the pop-up menu.

| B =2 |
[#] PAYROLLD.“pgm.chlle =]
PATROLLG. "pgr.rpgle
COMPARE “file. pf-src
EMPMST *file. pf-dta
EVFEVENT *file.pf-dta
-8 MSTDSP. file. dspf

&8 MSTDSP2. "file. dspf
PRIMST “fle.pf-dta
OCBLLESRC. *file.pf-src
QCLSRC. "file. pf-zrc
QACMDSRALC *file. pf-src
LDDSSRAC. file. pf-arc
ORPGLESRC. *file.pf-src
3 ILL.rpale
& PaYROLLGy  GoTo
QRPGLESRCP A —
REFMST *file. pf-d

i |

=

Open 'with
Brovze With

1[5 RSNMST file.pf-c_

C L MYCOMPIF fer
4] =™ O Rename. .

Remote Systerns | Team E5 Copy h
F= Pronartias | Q’ Move. .

PDM has display screens that list libraries, objects, members, and user-defined
options. There are two ways to get the same display list in the Remote System

Chapter 2. Starting the development environment
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Explorer, the Remote Systems view and the iSeries Table view.

tﬁ? Remote System Explorer - Welcome - WebSphere Development Studio Client for iSeries =] [E3

File Edit Mavigate Search Project Run ‘Window Help

|F-HE a8t -%-%-( <] -
== s v x Welcome X ] Outline X
|| &b | | Development S...
< « | AN outling iz
= = Thiz page tellz wou what pou should know before w not available.
: T with WWehSphere Development Studio Client for iSer
E ocel J sections below and click on the related links. =
5y s400a _|_I
=8, e 1| | 3
Wtk with librarie . : "
2 sy /ol with obiec [;h. iSeries Table View |=:>_'Eg G§F‘> ] v x
4]-' “work with memt Ize this view to display a list of ibems, for example, members or objects, |« |

a table format imilar to PO, You can aleo perform actions against thes

-, . i
i Library lst az editing and compiling,

T L
B User libraries

D"%k iSeries Commands *You can populate this view by either clicking the zolid black tiangle at t
[]—-% iSemnes Jobs of thiz wiew and selecting "Work with > Members or Wk with > Objects
[]—--*E‘D IFS Files or by right-clicking & parent object from the Remote Systems view and s__|
|| | Table.
‘ I I ’ d Pt ey [ oo NErE R ] It P T et [ R iy [ At RS sy I:.JLﬂ
Remaote S_l,lstems‘ Team ﬂ—l L
o
[ Froperties -
] | LCommand INormaI j I
E 5 [~
Froperty | Walue - Meszages I j Wetals. . | et Lo, |

Connected | ves o
1| | » Remote System Det... | Tasks IiSeries Table View‘ iSeries Commands L...

Subsystem: iSeniez Dbjects

In PDM, you perform actions on an object by specifying an option in the Opt field
next to the object. Generally, to perform actions against items in the Remote
System Explorer using the table view, you can right-click the item and choose from
the list of available options shown in the pop-up menu.

Show in Table

I Rename. ..
Copy
B Paste

+F Maove...
% Delete...

Update...

Chanage...

Save..

Restare..

FDM Options 3
User Actionz 4

Service Entry Faint #

Flun &z 3
Fiun(Frompt] 3
Marne Debug Az * | Attibute
CLR e s

MY COMPILE CLLE

RPGLE
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PDM allows you to apply the same operation to more than one item at a time.

=l Segsion A - [24 x 80]

File Edit “iew Communication Actions ‘Window Help

| 2% Em) &b (%] 22 o] elol

PF
FF-DT

01902 - Session successiully started

In the Remote System Explorer you can select multiple objects and apply the same

operation to these objects simultaneously. To apply an action to multiple items in

the Remote System Explorer:
1. Expand the filter that contains the items.

2. Select the items you want.

* To select consecutive items, click the first item, press and hold down the

SHIFT key, and then click the last item.

 REFMST.pf
Py RSMMST.pf
LRPGLESRAC. file. pf-arc
el PAvROLL ipgle
B PAYROLLG.ipgle
QORPGLESRCP. "file.pf-src
B PAYROLL.rpgle
ERFAVROLLG. rpale
REFMST “fle.pf-dta
RSMMST “fle. pf-dta
B MYCOMPILE. "emd J

il WDSCSURF “lib. prod-usr i
P #h User libraries hd|
Femate Syztems Team m

* To select non-consecutive items, press and hold down the CTRL key, and

then click each item.

* To select all the objects in the window, on the Edit menu, click Select All.

3. Right-click and select the action to apply to these items from the pop-up menu.

Chapter 2. Starting the development environment
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v X welco
Devel
PaYROLLD . *pgm.chlle =] -
= I3 [
PaYROLLG. "pam.rpale with
zechic
EMPMST "file. pf-dta
5 EVFEVENT “file.pf-dta
: . @€
(-5 MSTDSP. file. dspt T
788 MSTDSP2 "file. dspf ir
[ PRIMST “file. pf-dra
¢-E QCBLLESRAC. fle.phsic @rc
@-Ely DCLSAC. file.p-src I
-y QCMDSRAC fie pl-src I
=By ODDSSRC e pharc ¥
=-Ely ORPGLESRLC. "fle.phsrc L
) PA ROLLG.rpg
=-Ey ORPGLESACPflep  GoTo ’
REFMST *file. pf-dta :
RSMMST "file.pf-cha | DPEN With ;
| LR MYTTMPILE *ernd Brawse With 4
4
Remote S_l,lstemsJ Team M
o - = CDD}'

In PDM you can use the Prompt (F4) feature in some options to specify additional
parameters. In the Remote System Explorer, after certain actions, like the PDM
prompt, a wizard prompts for additional information.

The next chapter contains more concrete examples to help you explore additional
differences in the user interface.
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Chapter 3. Entering commands using the command line

When you use PDM you can enter commands directly on the command line.
Similarly, you can type any valid commands in the command line of the Remote
System Explorer using the iSeries Table view.

The iSeries Table view shows the same information as the Remote Systems view,
with the added ability to sort items, view descriptions, and perform other
PDM-like actions.

You can see the properties of all items at the same time, with each item as one
row in the table.

The selected file, library, or filter in the iSeries Objects subsystem is input for the
table when you select the Show in Table option from the pop-up menu.

Work with actions from the iSeries Table view populate the view with libraries,
objects, or members.

You can perform actions against these items, such as editing and compiling.

To populate the iSeries Table view, you can either:

Click the menu icon at the top of the view and select Work with and the type of
items you want to work with.

. T 5 =
i H . SEED & o
ise khis view ko display a list of items, for example, members or objects, in Libraries...
& table Format similar to PDM, You can also perform actions against these items such Objects. ..
as editing and compiling. Subset, ..
Members. .. 5
Stiav All
‘You can populate this view by either clicking the solid black triangle at the top Shmehnre
of this view and selecting Work with = Members or Work with = Objects, etc., bt
or by right-clicking a parent object from the Remote Systems view and selecting Show in oshion 0.,
Tohle. Pt yes
In general, ko perform actions against ikems, right-click the item For a list of options, Export toFile.
Preferences. .,
| | I
v
Command INDrmaI _'_] I _V_] Prompt. .. I R |
Messages I j Details... | Shoewlog.,.
Remate System Details | Tasks | iSeries Commands Lag ‘ iSeties Table View

13



* Or, right-click a parent item, such as a library or object, in the Remote Systems
view and select Show in table.

‘Whelcor
Develc

Expand To

£§3 Refresh
Expand
Collapse

Add Library List Entry...

E] F_I” Remove From Library List
7-[Ey 4} Move Up In Library List
JL Move Down In Library List
B

+F+ Mave Within Library List...

gl [
Remoke Systems | Team w Find String

In general, to perform actions against items in the workbench, right-click the item
for a list of options.

After populating the iSeries Table view, you can access the command line. You can
type the command and click Run or Prompt. The iSeries Commands Log view
automatically shows you any feedback.

[ 4y Library RSELABX: (21 Objects) |=€S_'Eg B a |y x
Marme I Tvpe I Aktribute I Text -
CLC1 HPiEM CLLE debuggable, calls Payralld, pe |
*PigM CLLE debuggable, calls Pavrallg, pe
*PiaM CLLE
*PiEM RPGLE
PAYROLLD *PiaM CELLE no errors

PAYROLLG *PiEM RPGLE | vI
»
Command INDrmaI j I * | Prompt... | Run |

Messages I j DEbals, . | ShawLog,. . |

Remate System Details |Tasks liSeries Table View ]iSeries Commands Log |i5eties Field Table View

You can also click on the cyan arrow to hide/show the command area.
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Listing detailed messages

When you use PDM you can view useful messages that are generated when you
enter commands on the command line if you use the list display mode. Similarly,
you can view detailed messages that are generated from the iSeries Table view
command line by clicking Details.

B Libr [+Eed @ 2 @ v x
Mame Type I Attribute I Text -
CLC1 HPiEM CLLE debuggable, calls Payvralld, P |
CLR1 *Pigh CLLE debuggable, calls Pavrallg, ps
MYZOMPILE *PiaM CLLE
PAYROLL *PEM RPGLE
PAYROLLD *FiaM CELLE no errors
PAYROLLG *PiEM RPGLE
1] |

o

Command INDrmaI

!

Messages ICurrent library changed to RSELABRX,

Remaote System Details |Tasks liSeries Table View ]iSeries Commands Log |i5eties Field Table View

Retrieving commands

Retrieving commands (F9) saves you from retyping the same commands in PDM.
This feature is also available in the iSeries Table view. Press F9 to retrieve a
command on the command line in the iSeries Table view. You can also add
parameter values to the command or modify parameter values for the command.
You can press F4 (Prompt) or click Prompt to prompt the display for the

command.

:ﬁa Change Current Library (CHGCURLIE) 5[

P an

Current library:

[ &l Parameters

bplicat
he
erfac__|
using

plica
éthat

[ Keywords

["| Advanced
b I CHGECURLIE CURLIB{RSELAEXK)
I, Libr
Mame
CLC]

o B

s56p o 2 m v x
;I Texk -

debuggable, calls Payralld, pe_ |

CLR]
YO a4 I Restore defauls Cancel

| debuggable, calls Pavrallg, pe

PaYROLL FPGM RPGLE
PAYROLLD *PaM CELLE no errors
PAYROLLG FPEM RPGLE
1 |
o
Command INormaI j | chgourlib rselabe:

Messages ICurrent library changed to RSELAEXX,

j Qetails...l Shiow Log, ..

Remate System Details |Tasks liSeries Table Yiew |iSeries Commands Log |iSeties Figld Table Yisw

Chapter 3. Entering commands using the command line
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Chapter 4. Objects, libraries, files, and members on the
iSeries server

As you know, objects are the basic unit on which commands perform operations on
the iSeries server. An object is a named unit that consists of both a set of features
that describe the object and a value. The features of an object include its name,
type, size, the date it was created, and a text description. The value of an object is
the collection of information stored in the object. The value of a program for
example, is the runnable code that makes up the program. The value of a file is the
collection of records that make up the file.

There are many types of objects. For example, the object type of a library is *LIB,
the object type of a file is *FILE, and the object type of a program is *PGM. Objects
can also have subtypes known as attributes, which are the characteristics of the
objects. For example, the attribute of an object of the *PGM type could be RPG, to
indicate that the program is created using RPG source code. The attribute of an
object of the *FILE type could be DSPF, to indicate that the file is a display file.

A library is a special type of object that is used to group related objects. A file is an
object of the *FILE type that has an attribute that describes the type of file (source
physical file, data file). A member is a subset of records in a file. Each member
conforms to the characteristics of the file.

The following table shows how to do each task in PDM and the Remote System
Explorer. For more information, see the tasks that follow.

Accessing iSeries objects

The following examples show you how to use the Remote Systems view to access
iSeries objects. Optionally, you can use the iSeries Table view to accomplish the
same task by using the Work with option from the drop-down menu.

I iseries Table Wiew . fi:
ilse this view ko display a lisk of items, for example, members or objects, in Libraties...
a table Format similar to PDM, You can also perform actions against these items such Objects. ..
as editing and compiling. Subset, ..,
Members..,
St Al
*fou can populate this view by either clicking the solid black triangle at the top chomceimns b
of this view and selecting Work with = Members or Work with = Objects, etc,, b
o by right-clicking a parent object from the Remote Systems view and selecting Show in oslHan 8.,
Table. Prifit. ..
In general, ko perform actions against items, right-click the item For a list of options, Export ko File.
Preferences. ..
1| | i
=
Command IP-JnrmaI j I j Brompt.,.. I Rumn I
Messages I LI DEkails. ., | Show Log... |
Remate Systern Details |Tasks |izeries Commands Log liSeries Table Wiew J

Filters in the Remote System Explorer

In the Remote System Explorer perspective, you can use filters to query your
iSeries server to list and perform actions upon libraries, objects, and members.
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Think of filters as a way to perform the same action you might be accustomed to
in Program Development Manager (PDM) to work with libraries (WRKLIBPDM),
work with objects (WRKOBJPDM), or work with members (WRKMBRPDM). The
Remote System Explorer perspective is designed to mimic these PDM actions, and
perform many additional actions not possible in PDM.

When you create a filter in the Remote Systems view by expanding Work with
libraries, Work with objects, or Work with members, your selections in the
filtering wizard create a filter string. For example, you can define a filter string to
query all members of the *rpgle type in your current library. After you define your
filter, you can re-open it to add another filter string, for example, to also find
members of the *mnucmd type in the same library or a different library. When you
access the list by expanding the filter, you can see the Native iSeries File System
items (libraries, objects, and members) and perform actions (such as editing,
compiling, running, and debugging) on these remote items.

Filters are persistent -- when you reopen the workbench at a later time, the filters
that you created earlier are still available.

Viewing a library list
To view the library list (*LIBL and *USRLIBL) in PDM:
1. Select option 1 (Work with libraries) from the PDM menu.

2. Press Enter and type one of the options provided in the prompt to display the
list.

In the Remote System Explorer, library list filters display the *LIBL library list from
your iSeries server in the Remote Systems view. When expanded, the filter
provides the same actions as a library filter, with additional actions for
manipulating the library list.

Note: If you are using your default profile, the wizard assumes that you already
have a library list. Therefore, this action only applies if you are using a team
profile, or an additional personal profile.

To access your library list in the Remote System Explorer:

1. In the Remote Systems view, expand your connection, and then expand iSeries
Objects. Right-click iSeries Objects and select New > Library List Filter.
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Note: This action corresponds to the EDTLIBL command in PDM.

L 1M %
& b | s

-8 Mew Connection
i MY Windows..

-y iSeries...

il Connection created successfully. Expar
Local

3 Golnto
Iy Wor GoTo
Ay Libr: N Library Filter... K
z |,

i Use 7 Open Member... N Object Filter..

; %ﬁj iSenes [ . .
& iSeries J R Openi % Member Filter...

i Mew Window

= . '

Enter a name for the filter.

Note: You give your filters a name because the Remote System Explorer saves
them for future use. PDM does not save filters.

Select the Only create filter in this connection check box if you want the filter

to display only in your current connection. Otherwise, it displays in all your
connections.

Select the profile you want to use for this filter. You can use an individually

created profile to keep your work private or the team profile to share with
others. In this instance, use your team profile.

Library List Filter -
o = U

Create a new iSeries library list filker ?:{>
=i

Filters are saved for easy re-use. Specify a unique name for this filker. This name wil
appear in the Remote Systems view, and will be expandable.

Filter name: | Team Libramy Lis|

[ Orily create fiter in this connection

Select a profile to awn the new filker. This determines if it iz unique to you, or sharable
by the team. [t will be placed in the default filter pool for that profile.

Owarer profile: | Team j

< Hank | Mest > | Finish I Cancel |

5. Click Next and click Finish.
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You can see your new library list filter in the Remote Systems view under
iSeries Objects.

IIr | Rem

R
© A windows... =]
f) Lir...

B Local ..
! BB Seriss...
il Connection created successhully. Ex
-8 Local

= «400a

L——_IED iSenies Objects

Hﬂ whark, with libraries...

H Work with objects...

T Work with members...

-l Librany list

iﬁb User libraries

[]—-ﬁ iSenes Commands

B @ iSeries Jobs
¥t IFS Files

4] | EE

Fiemate Syztems I Team

Tip: You can drag and drop filters from one subsystem or filter pool to another, as
long as they have the same subsystem type. Also, if you drag a filter into

another filter, the target filter is updated with filter strings from the first filter,
to combine them.

Viewing a library

To view a list of libraries (*ALL, *ALLUSR, *CURLIB, name, *generic) in PDM
1. Select option 1 (Work with libraries) from the PDM menu.

2. Press Enter and type one of the options provided in the prompt to display the
list.

Library filters list a set of libraries from your iSeries server in the Remote Systems
view. To access a list of libraries in the Remote System Explorer:

1. In the Remote Systems view, expand your connection and then expand iSeries

Objects> Work with libraries.
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2. Expand Work with libraries.

By iSeries. .

E| Connection created successfully, Expar

---E, Local
=

H i Wiork with libraries..
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W Libramy st
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¥t IFS Files

1] | 2
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(You can also right-click iSeries Objects, or your filter pool, and select New >
Library filter.)

II[ | Rk - v

E2ed|loo xS
=& MNew Caonnection
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=y s400a

L:-"'E‘D =
T . torv...

Go Into & e
2 Library List Filker. .
Go To 3 b ¥

Library Filker...

L 4 Open Member. ..

- ise : -
[]"g 2 % Open in MNew Window E’A Mamber Filter ..

BB I ) show in Table T

X Object Filter. .

Note: Expanding Work with libraries corresponds to the WRKLIBPDM
command in PDM, and it also creates and expands the filter in the
Remote Systems view.
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3. Select a generic or specific library name from the Library drop-down list, or,
type a generic name such as Y* to list all libraries that start with Y.

Library Filter -

Create a new iSeries librany filter %D
mp

Librany: |7 jJ Browse...l

¢ Bk I Mest > I Eiristy | Cancel |

You can also click Browse to locate libraries. Click Next.

4. Enter a name for your filter.

Note: You give your filters a name because the Remote System Explorer saves
them for future use. PDM does not save filters.

5. Select the Only create filter in this connection check box if you want the filter
to display only in your current connection. Otherwise, it displays in all your
connections.

Library Filter

tame the new filker %D
ol

Filters are saved for easy re-use. Specify a unique name for this filker. This name wil
appear in the Remote Systems view, and will be expandable.

Filter name: | Libraries

[ Orily create fiter in this connection %

Select a profile to own the new filker. This determines if it iz unique to you, or sharable
by the team. [t will be placed in the default filter poal for that profile.

COwirer prafile: | innovations j

¢ Back | Mest > | Einish I Cancel |

6. Select the profile you want to use for this filter. You can use an individually
created profile to keep your work private or the Team profile to share with
others. In this instance, use your default private profile.

7. Click Next to see more text information about the filter or click Finish.
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Your new library filter now displays in the Remote Systems view under iSeries
Objects.

2| | HF
J,; Mew Connection
- Local
-4 s400a
E-Ety iSeries Ohjacts
2125 whork with libraries. ..
E Filter created successfully, Expa
755 Wwhark with objects...
-4 Whork with members. ..
- Library list
iﬁb User libraries
-y, rameLMib, prod
-y vaMTZL *ib.prod
-, ¥IDOU.Mib,prod
[]—-“ iSeties Commands
[ Eiy iSeries Jobs
¥y IFS Files

| | i

Remate Systems ITeam

Viewing a list of objects
To view a list of objects in PDM:
1. Select option 2 (Work with objects) from the PDM menu, and pressEnter.

2. Type one of the options from the prompt for each of the fields: Library, Object
name, Object type, Object attribute, and then press Enter. PDM displays the list
of objects.

In the Remote Systems Explorer, object filters list a set of objects from your iSeries
server in the Remote Systems view. With the filter, you can use this list again later.

To access a list of objects in the Remote System Explorer:

1. In the Remote Systems view, expand your connection and then expand iSeries
Objects. Expand Work with objects. (You can also right-click iSeries Objects,
or your filter pool, and select New > Object filter.)
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2. Expand Work with objects. (You can also right-click iSeries Objects, or your
filter pool, and select New > Object filter.)

E EMate JYEtems
EP|le o | H

i,; Mew Connection
#-B Local

58
=@y iSeries Objects
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- Library list
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gk iSeries Cammands
-y iSeries Jobs

Bl Ty IFS Files

Femate Syztems I Team

Note: Expanding Work with objects corresponds to the WRKOBJPDM
command in PDM.

3. Browse, specify, or select from the Library drop-down list the library that
contains your objects.
4. Enter a generic or specific object in the Object field, or click Browse to select

one. The default is * (asterisk), and you can use up to ten characters. You can,
for example, enter t* to list all objects that start with t.

Object Filter

e i
Create a new iSeries object fiker ?ED

¥

Librarny [rarL =1 Browse.. |

Object [t =l Browse.. |

Obiectype: | =l Brawse... |

Obiest attibute: [i = di
|

tore Typess>»

I3
< ek I Mest > I Eiristy | Cancel |

5. To define object types, you can browse, specify, select from the drop-down list,
or click More Types to select from all known object types.

6. To define object attributes, you can browse, specify, or select from the
drop-down list. You can only enter a single object type and attribute pair per

filter, until you change a filter to add more filter strings (see: Modifying a list
of items by modifying a filter).
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7. Click Next.

8. Enter a name for your filter.

Object Filter

Mame the nevs filter ?E”D
=1

Filters are saved for easy re-use. Specify a unique name for this filker. This name wil
appear in the Remote Systems view, and will be expandable.

Filter name: | T Objects

[ Orily create fiter in this connection

Select a profile to own the new filker. This determines if it iz unique to you, or sharable
by the team. [t will be placed in the default filter pool for that profile.

Cwarer profile: | innoyations % j

Select the profile whoze default filb
< Back | Mest > | Finish I Cancel

9. Select the Only create filter in this connection check box if you want the
filter to display only in your current connection. Otherwise, it displays in all
your connections.

10. Select the profile you want to use for this filter. You can use an individually
created profile to keep your work private or the team profile to share with
others. In this instance, use your default private profile.

11. Click Next to see more text information about the filter, or click Finish. You
can see your new object filter in the Remote Systems under iSeries Objects.

Bl | HSF
=1l s400s -]
B ED i5enies Objects i
75t wwark with libraries...

]’[5’ Whark with objscts..

| Filter created successfully. Expar
Y work with members...

W Library list
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=/,

TESTPGM. "pam.cle
TCPRCLST *pgm.clp
TRAMSFER. “pgm.chl
TRAMSFERD. "pgm.chl
TCLISTS "file.pf-dta
TCLISTSOLD. *file. pf-dta
TCLISTSPY “file.pf-dta
TCLISTS 1. file. pf-dta
TCLISTS1_L "file. pf-dta

& TCLISTSIC Hfile nfdta i
1] | »
Fiemate Sy&tem&l Team

You can also search for iSeries member strings if you have a number of member
filters and you want to know which one includes a particular string you remember
defining. To search for member strings, either press CTRL+h or click Search >
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Search from the menu bar. Click the iSeries Search tab, specify the search string
and any other criteria in the dialog box, and click Search.

Viewing a list of members
To view a list of members in PDM.:

1. Select option 3 (Work with members) from the PDM menu, and press Enter. Or
type WRKMBRPDM in the command line and press Enter.

2. Type one of the options from the prompt for each of the fields: File, Library,
Member name, Member type, and then press Enter. PDM displays the list of
members.

In the Remote Systems Explorer, member filters list a set of source and data
members from your iSeries server in the Remote Systems view. With the filter, you
can use this list again later.

To view a list of members in the Remote System Explorer:

1. In the Remote Systems view, expand your connection and then expand iSeries
Objects.

2. Expand Work with members. (You can also right-click iSeries Objects and
select New > Member filter.)

EP|le o | H

- Mew Connection
&-B Local

B- iSenies Dbjects
E-5T whork with libraries...
'ﬂj’ ‘work with members...
gl LT
iﬁb User libraries
Bk iSeries Commands
& iSeries Jobs
[ ¥y IFS Files

Fiemate Syztems I Team

Note: Expanding Work with members corresponds to the WRKMBRPDM
command in PDM.

3. Browse, specify, or select from the Library drop-down list the library that
contains your source members.

4. Browse, specify, or select from the File drop-down list the file within the
library that contains the appropriate source members.

5. Enter a generic or specific member name in the Member field. The default is *
(asterisk), and you can use up to 10 characters. You can, for example, enter s=*
to list all members that start with s.

6. (Optional) To select a specific member type, enter the type in the Member
type field, or click More Types to select from all known object types.
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7. Use the check boxes to select whether you want to list source members, data
members, or both. Select at least one check box, and then click Next.

Member Filter :
1l
= s

14

Create a new iSeries member filter

Librany: [REELAERR =1 Elleriee |
File: |oRPGLESRCP =1 Browse... |
Member:  |PAY" = Browse... |
Member type: |7 =l Brows... |
More Types>» |
¥ Source members [T Datamemibers
I3
cBack | New> Fiish | Cancel

8. Enter a name for your filter.

Note: You give your filters a name because the Remote System Explorer saves
them for future use. PDM does not save filters.

9. (Optional) Select the Only create filter in this connection check box if you
want the filter to display only in your current connection. Otherwise, it
displays in all your connections.

10. Select the profile you want to use for this filter. You can use a personal profile
to keep your work private or the team profile to share with others. In this
instance, use your default private profile.

11. Click Next to see more text information about the filter, or click Finish. You
can see your new member filter in the Remote Systems view under iSeries
Objects.
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Chapter 4. Objects, libraries, files, and members on the iSeries server 27



Tip: You can search for iSeries member strings. You can either press CTRL+H or
click Search > Search from the workbench menu. Click the iSeries Search
tab, specify the search string and any other criteria in the dialog box, and
then click Search.

Modifying a list of items (by modifying a filter)
You can change the properties for any filter by opening the filter’s properties page.
You can also add new filter strings to a filter from this page. For example, if you

have a filter that lists all RPGLE source members, you can add an additional filter
string that will display all CBLLE source members as well.

To change a filter:

1. In the Remote Systems view, expand your connection name, and then expand
iSeries Objects to view the list of your filters.

2. Right-click the filter you want to change and select Properties.

A Renarne. .

5
& & | ESBa
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I B Local & Move..
B- ‘ z400a # Delete...
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l ﬁ) Library I
. i}*’ User libr [ Find String...
I P Payrol
iﬁb " Librar

Froperties

3. In the Properties window, click Filter Strings to change the filter’s
specifications (what the filter lists from the iSeries server). For example, change
the value in the Library field. Then click Apply.
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¢ If you want to add extra filter strings for your filter, click New filter string
and complete the dialog box. Then click Apply.

&P Properties for Y Library

- Filter Information Filter Strings

Few filter string

4. Click OK.

Deleting filters

Deleting a filter does not delete any elements that you manage with that filter. You
only delete your specific configuration for that filter.
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1. In the Remote Systems view, expand your connection, and then expand iSeries
Objects.

-
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2. Right-click your filer and select Delete.

Applying options to an object

The actions that you can apply to an object are listed as options in PDM. For

example, in the options column, you can enter 2 to change, 3 to copy, 4 to delete,
and so on.

To see the available actions that can be applied to a particular item in the Remote
System Explorer:

1. In the Remote Systems view, expand the filter beneath iSeries Objects that
contains the item you want to work with.
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2. Select and right-click on the item. A pop-up menu shows the list of options that

can be applied to the item.
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Applying an action to multiple objects

When you use PDM you can apply the same operation to more than one item at a

time.

To apply an action to multiple items in the Remote System Explorer:
1. Expand the filter that contains the items.
2. Select the items you want.

* To select consecutive items, click the first item, press and hold down the
SHIFT key, and then click the last item.
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* To select non-consecutive items, press and hold down the CTRL key, and
then click each item.
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* To select all the objects in the window, on the Edit menu, click Select All.

3. Right-click and select the action to apply to these items from the pop-up menu.

Displaying the description of objects

When working with PDM, you can display the following information about an

item:
1. Item size

Time and date the item was created

2

3. Time and date the item was changed
4. Time and date the item was last saved
5

Time and date the item was last restored

To display the description of an item in the Remote System Explorer:

1. In the Remote Systems view, expand your connection, and then expand iSeries

Objects.
2. Expand your filter that contains the item you want to see.
&P Properties for RSELABXX k _ O] =]
- Library Info Advanced Info
. Diskieic wner WEISS
- Source and Service Info Primary group: "MONE
Object auditing walus: “MONE
— Creatioh infarmation
Created: bap 10, 2007 8:31:27 Ak
Created by: BATTHISH
Swystem created on: TORAS 94k
System level: YWO4R05M00
Diomnain: “SYSTEM
— Change/usage information
Modified: June 3, 2004 12:37:48 P
Usage data collected: Ho
Last used date: January 1, 197001 2.00:00 AM
Daps uzed count; i}
Feset date: Jarwary 1, 19701 2:00:00 Ak
Allow change by program: Yes
Changed by program: Mo
Changed by uzer: Yes
ar. I Cancel

3. Right-click on the item and select Properties from the pop-up menu.

4. Under Advanced Info, you can view the details of the item.
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Chapter 5. Working with items

You can use the Remote System Explorer to modify items, item features and item
attributes. In this section, you can see how easy it is to modify iSeries items using
the Remote System Explorer and to have the powerful prompt wizards guide you
to properly complete the action you want.

Creating items

To create an object in PDM:

Select option 5 (Programming) from the main menu.

Select option 2 (PDM).

Select option 2 (Work with objects).

Press Enter to bypass the Specify Items to Work with page.

Press F6 in the Work with objects screen to list all the create commands.

Type the command number in the command line and Press Enter.

N o oD~

At the Create prompt, type the information and press Enter to create an object.

Creating source physical files

In the Remote System Explorer, you can create new source physical files in the
iSeries Objects subsystem or the iSeries Commands subsystem. The advantage of
the iSeries Objects subsystem is that you can navigate through your libraries to the
location where you want to create the file, and the advantage of the iSeries

Commands subsystem is that you can specify more parameters (for more advanced
users).

Method 1: To create a source physical file in the iSeries Objects subsystem:

1. In the Remote Systems view, expand your connection, and then expand iSeries
Objects > Library list.

2. Right-click the library in which you want to create the source physical file, and
select New > Source Physical File.
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3. Enter the name of the source physical file you want to create, or click Browse
to retrieve a source physical file from a specific library. If you browse to an
existing source physical file, you need to rename it after it appears in the File
field.

4. Enter the record length for the source physical file.
5. (Optional) Add a description in the Text field.

6. (Optional) Click Next to define advanced features for your source physical file,
such as Authority, Coded character set ID, or ICG data.

7. Click Finish. You can see your new source physical file under the library you
selected.

Method 2: To create a source physical file from the iSeries Commands subsystem:

1. In the Remote Systems view, expand your connection, and expand iSeries
Commands > Create source file.

Ll | HSF

B iSeries Objects -]
K Whark with libraries. .
zlj Whork, with objects...
Y Work with members...
W Library list
i User libraries
= H i5enes Commatds
B _'ﬁD Tour cammand(z)...
F Add library to librany list
}"{D Change current libram
%‘D Femaove library fram library list

I _ﬁb Create duplicate object ;l

Fiemate Syztems I Team

2. Specify or select parameters for the file. Click Advanced for extra parameters.
3. Click OK.

Creating message files

In the Remote System Explorer, you can create message files in libraries on your
iSeries server, similar to the CRTMSGF command in PDM, which creates a message
file for storing message descriptions. You can add message descriptions to the
message file, edit your message descriptions, and display the descriptions in the
iSeries Table view.

To create a message file in the Remote System Explorer: :

1. In the Remote Systems view, expand your connection, and then expand iSeries
Objects > Library list.
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6.

Right-click the library in which you want to create the message file, and select
New > Message File.

=
E% Library list =]
W, 055 b prod-sps

'})5 Q552 "lib.prod-sys

W, QHLPSYS “lib.prod-sys

i, GUSRSYS fib.prod-sys

I, QGPL it prod-usr

Wil S FLAER, b test-usr

Ml WS SLARR b prod-ust

= R e

CLC

L—ﬁ‘ Source Physical File...
» .

tEr o e File...
MY -
=TRe Sl P o DataQueue...
PAY &5 Refresh (v Data direa. .
PAY
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Enter the name of the message file you want to create, or click Browse to select
a message file from a specific library. If you browse to an existing message file,
you need to rename it after it appears in the Message file field.

(Optional) Add a description in the Text field.

(Optional) Click Next to define advanced options for your message file, such as
authority, coded character set ID, or file size.

Click Finish.

Creating data queues

In the Remote System Explorer, you can create data queues in libraries on your
iSeries server, similar to the CRTDTAQ command in PDM.

To create a data queue:

1.

2.

3.

In the Remote Systems view, expand your connection, and then expand iSeries
Objects > Library list.

Right-click the library in which you want to create the data queue, and select
New > Data Queue.
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Enter the name of the data queue you want to create, or click Browse to select
a data queue from a specific library. If you choose to an existing data queue,
you need to rename it after it appears in the Data queue field.
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7.

(Optional) Alter the size of the data queue if necessary. The maximum length is
64512.

(Optional) Add a description in the Text field.

(Optional) Click Next to define advanced options for your data queue, such as
authority, force to auxiliary storage, sequence, queue size, and auto-reclaim.

Click Finish. You can see your new data queue under the library you selected.

Creating data areas

In the Remote System Explorer, you can create data areas in libraries on your
iSeries server, similar to the CRTDTAARA command in PDM.

To create a data area:

1.

7.

In the Remote Systems view, expand your connection, and expand iSeries
Objects > Library list.

Right-click the library in which you want to create the data queue, and select
New > Data Area.

X |

= 5
—— n

-y Library list

Al Q5SS lib.prod-sys
Q552 lib.prod-sys
AHLPSYS “lib. prod-gys
QUSRSYS. "lib. prod-sps
AGPL.lib. prod-usr
WAFLABX b test-usr
WSS LARR, "lib. prod-usr

]

CLC1."pgm.cle 2 Source Physical File.
# ol
CLA. "pgm.clls aolo [} Message File...
MCOMPILE. "pgrn.¢ EpenE T v

PaYROLL. *pgm.rpgl
PATYROLLD. “pam.ct C_{}G‘p Refresh

PATROLLG. "pgr.ip Erpatd

Remate Systems | Team Collapze

N Object Filter. .

Enter the name of the data area you want to create, or click Browse to select a
data area from a specific library. If you browse to an existing data area, you
need to rename it after it appears in the Data area field.

Select the type of data area you want to create
(Optional) Add a description in the Text field.

(Optional) Click Next to define advanced options for your data queue, such as
authority, length information, or the initial value.

Click Finish.

Creating members directly in the iSeries Objects subsystem

You can create a new member in the Remote System Explorer using either the
iSeries Objects subsystem or the iSeries Commands subsystem. The advantage of
the iSeries Objects subsystem is that you can navigate through your libraries and
files to the location where you want to create the member, giving the member
location a context. The advantage of the iSeries Commands subsystem is that you
can specify more parameters (useful for more advanced users).

Method 1: To create a member from the iSeries Objects subsystem:

1.

In the Remote Systems view, expand your connection, and expand iSeries
Objects > Library list.
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1.

Select and expand the library and source physical file in which you want to

create a member.

Right-click the source physical file and select New > Member.
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member from a specific library and source physical file. If you browse to an
existing member, you need to rename it after it appears in the File field.

EP|le o | H

-2k Wwhork with objects...

'ﬂj’ Whark with members...

¥4 Libramy list

-l Ulser libraries

E-g% i5eries Commands

}:b Your cammand(z)...

T Add library to libramy list

}'ﬁ't} Change current library

Eflb Remove library from library list

:ﬁb Create libram
e

[]—-ﬂ. iSenies Jobs
- IFS Files

-

Fiemate Syztems I Team

parameters.
3. Click OK.

Enter the member type or select from the available items in the list.
(Optional) Add a description in the Text field.
7. Click Finish.

Method 2: To create a member from the iSeries Commands subsystem:

In the Remote Systems view, expand your connection, and expand iSeries
Commands > Create source member.

2. Specify or select parameters for the member. Click Advanced for extra

Enter the name of the member you want to create, or click Browse to retrieve a

Deleting Items

To delete an item in the Remote System Explorer:

1. In the Remote Systems view, expand your connection, and then expand iSeries

Objects.

2. Expand your filter that contains the item you want to delete.
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3. Right-click on the item and select Delete from the pop-up menu.

Fep|le s | HS

El fin iSeries Objects ;I

25 Wwark with lbraries...

-2 Wwork with objects. .

-2 Wwork with members. .

L——_I# Library list

B, 0575 lb.prod-sys

o, 05752 lb.prod-sys

- AHLPSYS . "lib prod-ays

Wl BUSRSYS “lb.prod-sys

HGPL it prod-usr

il WFLAB:. lib.test-usr

oy WS SLABR, “lib. prod-usr

B, RSELABNH, Frmanten
H CLCT “pai GoTo 3

ﬁbﬁcﬁﬁﬁ £ Showin Table

PAYROL

PaYROLL

payROLL|  Eepand

[y COMPER [Balamse

EMPMST

EVFEVEN I Rename. ..

& M5TDSP, 52 Copy

MSTDSPI|g Bt

PRIMST.

Ehy aCeLLeg S Haves

Remote Systems J Team

l@§3 Refresh

L

Renaming Items

To rename an item in the Remote System Explorer:

1. In the Remote Systems view, expand your connection, and then expand iSeries
Objects.

2. Expand your filter that contains the item you want to rename.
3. Right-click on the item and select Rename from the pop-up menu.
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Copying items

You can copy and paste files, objects, or members not only between libraries and
objects on the iSeries server, but between different servers as well. For example,
you can copy one or more files from one library in your iSeries server to another,
or from your iSeries to your Linux server. However, there are guidelines for what
kinds of items you can copy and paste. You can copy and paste source physical
files and libraries between different places on your iSeries server, or from one

iSeries server to another, but you cannot copy them to a universal server, such as a
UNIX or Windows server.

To copy and paste items:

1. In the Remote Systems view, expand the two connections (that represent the
two servers) until you see the item you want to copy and the location on the
other server where you want to paste the item.

2. Right-click the original item and select Copy.
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3. Navigate through the directories and files until you find the place where you
want to paste the item.
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4. Right-click on the directory into which you want to paste your item, and select
Paste.
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Drag and drop action

The drag and drop action supports files, items, members and filters, but not
libraries. You can drag and drop filters from one subsystem or filter pool to
another. However, if you drag a filter into another filter, the target filter strings are
combined with the filter strings from the first filter.

To drag and drop items:

1. In the Remote Systems view, expand your connection(s) until you can see the
item you want to copy and the location where you want to paste the item. Or,
open two views that contain the item and the destination.
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2. Click the item once to select it, hold down the left mouse button while you
drag the item to the location you want, and then release the button.
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Creating a program

You can compile your iSeries members in the Remote Systems view. The pop-up
menu for source members includes compiler submenus with several commands for
various member types. A compiler name is an identifier for a compiler command
to run on a remote system. For example, the label CRTBNDRPG tells the iSeries
server to create a bound RPG program. Compiler names are only associated with
source member types: members (*MBR) and modules (*MODULE). For this reason,
you only see the options to compile when you right-click these types of elements.
There are two ways to compile: prompted and unprompted. Both compiler actions
invoke a submenu with a list of compiler names.

To compile source members from within the Remote Systems view:

1. Drill down to a source physical file member and right-click on it. You can select
more than one member to compile by holding down the CTRL key and
selecting the members (as long as they are compatible and from the same
iSeries connection).

2. Choose Compile or Compile (Prompt) from the menu with the appropriate
options:
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¢ Compile > CRTBNDRPG: This option creates a bound RPG program on the

iSeries server.
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Compile > CRTRPGMOD: This option creates an RPG module on the iSeries
server.

Compile > Work With Compile Commands: This option creates or edits
compile commands. You can choose the profile and the source member type
that you want to work with from the drop-down boxes at the top of the
window, and add, change, and delete compiler names.

Compile (Prompt) > CRTBNDRPG: This option creates a bound RPG
program on the iSeries server. You can specify or change options before
compiling the current file.

Compile (Prompt) > CRTRPGMOD: This option creates an RPG module on
the iSeries server. You can specify or change options before compiling the
current file.

Compile (Prompt) > Work With Compile Commands: This option creates or
edits compiler commands. You can choose the profile and the source member
type that you want to work with from the drop-down boxes at the top of the
window, and add, change, and delete compiler names.

If there are errors, the iSeries Error List shows the results of the compilation. The
compiler names available in these menus are determined from the associated
compiler names for each source type, and from the profile used to define the
connection.

To compile a program:

1.

In the Remote Systems view, drill down to a source physical file member and
right-click. You can select more than one member to compile by holding down
the CTRL key and selecting the members (as long as they are compatible and
from the same iSeries connection).

2. Select Compile > or Compile (Prompt) > and then one of the following:

* Select Appropriate Compile Command such as CRTBNDRPG: A compile

command associated with your selected source member type will display in
the pop-up menu for your convenience. For example, select CRTBNDRPG to
create a bound RPG program for a selected RPG file. If you want to use a
different compile command than one of the defaults, choose the second
option, described below.
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¢ Work With Compile Commands: Select the profile and the source member
type that you want to work with from the drop-down lists at the top of the
window, and add, change, or delete associated compile commands. This
option is also helpful if you want to use a different compiler command for
your source member, other than the default command in the pop-up menu. If
there are errors, the iSeries Error List shows the results of the compilation.

Run program objects

You can run program objects in PDM in either batch mode or interactively,
depending on the value you enter in the Run in batch prompt on the Change
Defaults display screen. To run an object in PDM:

1. Type STRPDM
2. Select option 2 (Work with objects).

3. Type information into the Specify Items to Work with page to find the object.
Press F23 to view more options.

4. Type 16 (Run) in the Opt column beside the program object you want to run.

To run programs in the Remote System Explorer, either right-click on the iSeries
object and select Run from the pop-up menu, or expand iSeries Commands and
select Run Command. At the prompt, specify the command and the job
environment that the program should run in: Normal (Remote Systems server job),
Batch, or Interactive.

Running programs and commands

The Remote System Explorer is built so that you can run programs and commands
on the iSeries server. The iSeries Commands Log view displays any returned
messages as your applications are run. You can select a program or command and
run it according to the type of application it invokes:

* As an iSeries Batch Application: This option uses the SBMJOB command to run
your application in the batch subsystem that is specified in your user profile.

* As an iSeries Interactive Application: For this option, your application runs in
the interactive job associated with the selected Remote System connection. If no
interactive job is associated with the connection, you are asked to use the
STRRSESVR command to associate the interactive job with the specified
connection.

* As an iSeries Application in the Remote System Explorer communication
server job: This option lets you run the program in the same job as the
communication server. This is useful if you use the communication server job to
set up your environment, your library list for example, and you need your
program to run in this environment.

* As an iSeries Multi-threaded Application: Use this option to run
multi-threaded applications. It creates a BCI job in QUSRWRK and runs the
application in that job. You can also use this option to run any batch application.
This option is only available for objects of type *PGM.

There are two distinct ways of invoking the Run action, with and without
prompting. If you run without prompt, the selected object is run in the selected
type of job with default values. If your program or command requires parameters,
use the prompt option.

Attention: When you run without prompting, a temporary launch configuration is
created with default settings as "My iSeries program to run”. In the Run
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Launch Configurations window, you can rename the launch
configuration and save it for future use.
To run a program or command without prompting, select a program or command
and do one of the following

* In the Remote Systems view, select Run As from the pop-up menu.
* In the iSeries Table view, select Run As from the pop-up menu.
e From the workbench Run menu, select Run As.

* From the menu icon next to the Run push button, select Run As.

To invoke a Run Launch Configurations window (Prompt) for a specific program
or command, select that program or command and do one of the following:

* In the Remote Systems view, select Run (Prompt) from the pop-up menu.
* In the iSeries Table view, select Run (Prompt) from the pop-up menu.

e From the workbench Run menu, select Run....

* From the menu icon next to the Run push button, select Run....

In the Launch Configurations window, specify parameters for your application.

Editing members

When you use PDM, you can edit a member only in a file that is a source physical
file. PDM calls the source entry utility (SEU), which you can use to edit the
member.

In the RSE, use the Remote Systems LPEX editor or one of the other editors to edit
your members. Many of the editing features offered in CODE for RPG, COBOL,
CL, and DDS source, such as syntax checking, automatic uppercasing, program
verification, and so on, are available in the Remote Systems LPEX editor.

To edit source in the Remote Systems LPEX editor:

1. Drill down through your files in the Remote Systems view until you find the
member you want to edit.

2. Double-click the member, or right-click the member and select Open With >
Remote Systems LPEX Editor.

3. With your cursor in the source, right-click and select an option from the pop-up
menu. The available options depend on the type of file you are editing. See the
online documentation for more information about the LPEX Editor.

. 5By URPGLESRC fle.pfsrc " ‘

GoTo Pl

Dpen ith Pl # Remate Systerms LPEX E ditor

T » -
Browese With {9 CODE Editor

Tip: You can switch between files you have open in the Editor view by pressing
CTRL+Fé.

Compiling Members

In both PDM and the Remote System Explorer, you can compile a member only if
the member is in a source physical file. When you compile a member, the
appropriate create command is called for the member type.
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You can compile your iSeries members in the Remote Systems view. The pop-up
menu for source members includes compile submenus with compile commands for
various member types. A compile name identifies a compile command to run on a
remote system. For example, the compile label CRTBNDRPG tells the iSeries server
to create a bound RPG program. Compile names are associated only with source
member types: members (*MBR) and modules (*MODULE). For this reason, you
see compile options only when you right-click these types of elements. You can
compile with prompts or without prompts. Both compile actions invoke a submenu
with a list of compile names.

To compile source members from the Remote Systems view:

1. In the Remote Systems view, drill down to a source physical file member and
right-click. You can select multiple files by holding down the CTRL key and
clicking various members (as long as they are compatible and from the same
iSeries connection).

2. Select Compile > or Compile (Prompt) > and then one of the following:

* Select Appropriate Compile Command such as CRTBNDRPG: The pop-up
menu provides a compile command for the selected source member type. For
example, select CRTBNDRPG to create a bound RPG program for a selected
RPG file. To use a different compile command, choose the next option.

* Work With Compile Commands: Select the profile and the source member
type that you want to work with from the drop-down lists at the top of the
window, and add, change, or delete associated compile commands. Use this
option if you want to use a compile command for your source member other
than the default associated compile command in the pop-up menu.

If there are errors, the iSeries Error List shows the results of the compilation.
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Chapter 6. Applying actions to objects

Here you can see how some object specific actions are handled using the Remote
System Explorer.

Comparing file members

You can compare file members by using option 54 (Compare file member) in PDM.
This option is valid for all member types.

To compare files in the Remote System Explorer:

1. Drill-down through your files in the Remote Systems view until you find the
member you want to compare.

2. Double-click the member, or right-click the member and select Open With >
Remote Systems LPEX Editor.
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3. To compare an open member to another member, click Edit > Compare >
Compare from the menu bar.
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Changing the type and description of members

To update the text description of a member in the Remote System Explorer:
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1. In the Remote Systems view, expand your connection, and then expand iSeries
Objects.

2. Expand your filter that contains the member you want to view.
3. Right-click on the member and select Properties from the pop-up menu.

4. Under Member Info, you can view the description of the member. Here you
can update the type and the text description of a member.

&P Properties for PAYROLL _ O] x|
""" M Member Info
Marme: PaTROLL
File: [RPGLESRLC
Librany: RSELARR
Tupe: |RPGLE =l
Attribute: SRC
Test: I
Status: QK.
Creation date: Jure 5, 2000 20220 PM
Change date: Jure 5, 2004 12:05:21 P
Save date: July 23, 2003 1:35:45 P
Restore date: June 8, 2004 1:03:43 PM
Mumber of records: 457 %

Deleted records: I}

ar I Cancel

Moving a library to the user part of a library list

This action moves a library within your library list. You can only move a library
that belongs to the usr (user) section of your library list. To determine what section
a particular library belongs too, look at the extension at the end of the library
name:

* User libraries end with prod-usr
* Your current library ends with prod-cur

¢ System libraries end with prod-sys

You can also determine the type of each library in the Properties view, or by
right-clicking the library and selecting Properties. The type is beside the Attribute
field.

To move a library within your library list:
1. In the Remote Systems view, expand iSeries Objects > Library list.
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2. Right-click the user library you want to move and select Move within library

list.
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3. Select one of the radio buttons for where to position the library, for example,
Before.

4. Select a reference library from the drop-down list. For example, if you selected
Before in the previous step, and you select, for example, WSSLABXX as the
reference library, then you will place your library before the WSSLABXX

library.
5. Click OK.
. v x || #ruvrou [X|
=H§ %@ | | b =§= Row 1 Column 1 Rep.
—_—1  B........ i 2
- Mew Connection I -
L | DDDIDD F****‘k‘k***‘k‘k***‘k‘k*
E|--- ;gga 000200 F* FPROGRAM MANE -
=g iSeres Objects &b Move Library List Entrp Ed
72wk with libraries
.. Selected ibrary:  RSELABK

o Work with objects...

WY work with members.
=g Library list

W 0575 b prod-sys

W, 0552 b prod-sps
'})5 AHLPSYS "lib. prod-sys
W, QUSRSYS fib.prod-sps
Wi, GGPL b prod-usr

Reference librar | 'wSSLAB
“where to move | JGPL
 After

=

i, WFLABRA b test-usr
Wi, WS SLAER, b prod-ust
il PSELABXA b prod-usr

RMVLIELE LIB[RSELABA]

ADDLIBLE LIBRSELAB:<] POSITION["BEFORE
WSSLARKK)

ﬂ\ WOSCSUBF. b, prod-usr
- User fbraries

B-B% iSeries Commands

. B iSaniac lohe

S

Cancel

Removing a library from the user part of a library list

This action removes a library from your library list. Once again, you can only
remove a library that belongs to the usr (user) section of your library list.

To remove libraries from your library list:
1. In the Remote Systems view, expand iSeries Objects > Library list.
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2. Right-click the user library you want to remove and select Remove from
Library List.
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Chapter 7. Searching for text strings on the iSeries server

You can search for text strings on your native iSeries server in the Remote System
Explorer.

This action corresponds to the FNDSTRPDM command in PDM, which searches
for strings in a member.

The option in the Remote System Explorer searches libraries and filters as well as
members. You can search the native iSeries file system from either the Remote
Systems view or the populated iSeries Table view. When the search is finished, you
can use the pop-up menu to perform actions against the items listed.

This option is flexible in that you can select multiple items, which can be of the
same or of different types. For example, you can select a source member from one
library and a physical file from another library, and search for the same string. You
can also select a filter and a library, and then search them together.

You can search either from a selection, or from the entire iSeries server. When you
search from a selection, you navigate through your libraries and files until you find
the item you want to search. When you search from the entire iSeries server, you
do not begin with any item. Your search is as broad as you want it to be, and you
can narrow the search by specifying certain libraries, files, or member names to
search.

To search for strings from a selection:

1. In the Remote Systems view, expand your native iSeries connection until you
reach the item that you want to search. Or, navigate through items shown in
the iSeries Table view. Select the containing item by clicking on the item.
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2. Right-click and select Find string. Or, click Search > Find string from the

workbench menu.
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3. In the Find String window, specify the string that you want to search in the
Search string field.

4. Select the Case sensitive check box if applicable.

5. The Scope area displays the targets that you have selected. If you are searching
libraries or library filters, two check boxes beneath this area are enabled:
Source members (selected by default) and Data members. Select Data
members if you also want to search data members, which takes longer.

&P Find String | x]
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& All columng
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o ]
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6. If applicable, specify columns to search with the Columns radio buttons. By
default, all columns are searched.

7. Click OK.

To search for strings from the entire iSeries server:
1. Click Search > iSeries from the workbench menu.

2. In the iSeries Search tab of the Search window, specify the string that you
want to search in the Search string field.

'@ Remote System Explorer - WebSphere Development Studio

File Edit Mavigate | Search Project Fun Window Help

J - <# Search... Ctrl+H E
x

=4l s re iz

=H\-= New Cor W Remote...
Local | 542 Help...

3. Select the Case sensitive check box if applicable.

4. Use the Target area to specify the target that you want to search. The names
can be generic. If the file name is generic, the Source members (selected by
default) and Data members check boxes are enabled. Check Data members if
you also want to search data members, which takes longer.

5. If applicable, specify columns to search with the Columns radio buttons. By
default, all columns are searched.

P iseries Search ||% File Sealchl 4 Help Sealchl ¥ Java Searchl 2 Plugin Sec 4 I 'I
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Cannection: Is4EIUa j M. |
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[¥| Source members [0 Dtz membens
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Customize...l Search I Cancel

6. Click OK.

In the Remote Search view, you can view the strings and files that you searched
for, with the matches listed underneath as a tree.

To manipulate the set of search results:
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* Right-click the parent items of the tree and select any of the regular Remote
Systems options, for example, Open With, PDM Options, Properties, and so on.

* Right-click any line beneath the parent search item in the tree
— Select Open with to lock and open the member in an editor.

— Select Browse with to open the member in an editor without locking the
member on the server.

* Double-click the parent or item to open the member with the cursor on the line
that was found.
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Chapter 8. Working with user actions (user options)

In Remote System Explorer, user actions are server commands that you define and
run on iSeries libraries, objects, jobs, and members. You can also define user
actions for folders and files in any remote UNIX, Windows, Linux, Local, or IFS
file system.

Each user action has several characteristics:
* A unique name.

* A command (that might have substitution variables). The user action specifies
how to run the command (normal, batch, interactive, or multi-threaded).

* Substitution variables that are replaced with contextual information when the
command is run.

* An optional comment used to describe the action in more detail.

* Various options to affect what happens when the command is run; for example,
whether to prompt first.

* One or more file types to scope what resource types apply to the action. For
example, a command to start SDA would be scoped to members of the DSPF
type. The action is shown only for remote objects, which is one of the specified

types.

Managing user actions (user options)

To create a new action or change an existing action in the Remote System Explorer:

1. In the Remote Systems view, expand your native iSeries connection, right-click
iSeries Objects, and select Work with > User actions. You can also right-click
on a file in one of your filters, and select User Actions > Work With User
Actions.
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2. Select Object action or Member action, depending on the type of action you
want to manipulate.
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3. Type a brief label for the action in the Action name field.
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4. Type descriptive information about the action in the Comment field.

5. Type the workstation or iSeries command string to run when a user selects this
action. When your action is run, the command can use action substitution
variables so that you do not have to explicitly code command parameter
values. Click Insert variable to view and select valid variables.

Additional parameters
1. Select Edit to change the command entered.

2. Select Browse to search for and select command files (for example, sys
commands). The file name you select is reflected in the Command field when
you return.

3. Select Prompt to prompt the command currently entered in the Command area.

4. Select Refresh after to refresh the selected files after the command for the
action is run. This is useful if your command affects the information displayed
in the file list window for the selected files, for example, if your command
changes the type or description of a member.

5. Select Single selection only to show the action only when a single object is
selected.

6. Select Invoke once to collect the full names of all selected resources into a
temporary member that is named by substitution variables ML, MF, and MM.
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7. Select any named types from the Defined Types list and click Add to include
them in the Selected Types list. The action is available only if a file matching
one of these types is selected.

You can also view user actions by active profile for remote objects on the User
Actions cascade menu. You can see both actions that are shared by the team and
actions that are private. To enable this, select Cascade user actions and compile
commands by profile on the Remote Systems view. (Click the drop-down menu
from the Remote Systems view and select Preferences > Remote Systems).
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